Instruction Manual for Operating
the Sensys System for
Temporary Traffic Counts
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Abbreviations:
AP: Access Point
FTP: File Transfer Protocol

RF: Radio Frequency

Notations:
Hyperlinks, or selectable buttons and tabs will be in bold italics (e.g. Hyperlink).
Labels on web pages or in software will be in italics (e.g. Labels).

Data to be entered into a field on a web page or in software will be in Lucida Console font
(e.9.192.168.2.99).
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1. Introduction

This Instruction Manual provides information and the procedures for using the Sensys System, which was
initially designed to operate in a server controlled network, for temporary traffic counts.

The instructions will allow the user to fully understand the Sensys Networks Vehicle Detection System,
properly configure the Sensys access point (AP) for the traffic count site, and retrieve the traffic count
data from the access point.

The instructions provided here are to accomplish the following tasks:

1.

Notes:

System Components and Requirements

Configuration of Field Laptop Computer

Configuration of the Sensors

Initial set up of Access Point

Backup and Restore of Access Point for multiple site application

Downloading Statistical Data & Exiting TrafficDOT Application

Some of the contents have been summarized from the Sensys Online Reference Manual. If more
clarification will be needed, view the Sensys Online Reference Manual at
www.sensysnetworks.com in the Dealer Login section or the Sensys Reference Guide in the
Technical Docs section..

These instructions are applicable to the Windows XP operating system.
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2. System Components and Requirements

The implementation of the Sensys system for temporary traffic counts requires the following components
for its basic operation:

>

Sensys Wireless Sensors

These are pavement mounted magnetometers equipped with wireless radio transmitters to detect
the presence and movement of vehicles.

Sensys Access Point

This is an intelligent device that establishes overall time synchronization of the system, transmits
configuration commands and message acknowledgements and receives and processes data from
the sensors. For the statistics —processing purpose of this project, the version of access point to be
used should be AP240 including the upgraded S version such as the AP240US or AP240ES. Any
other S-version could be used as well.

TrafficDOT Software

This is monitoring application software from Sensys network that provides graphical user
interface (GUI) to the components of Sensys Traffic count system. (Installation will be explained
in Section 2).

Laptop Computer with an Ethernet port.

The instructions on this manual are based on Windows XP Operating System. The Mac, Unix,
Linux or other Windows can also be used based on a different instruction set. Minimum
requirements are: 40GB HDD, 1.8GHz CPU, 1024MB Memory, and the Mozilla Firefox web
browser.

Ethernet Cable

Use a Cat 5 or a better Ethernet cable that is at least 1.5m long terminated with male RJ 45
connectors on both ends.
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3. Configuration of the Field Laptop Computer

The laptop computer used to communicate with the Sensys access point must meet the following
requirements:

1. Laptop must be configured to a fixed IP address.

2. Laptop must have TrafficDOT application software installed
3.1 Configuring the Laptop to a Fixed IP Address
The IP Address is found under Network Connections.

» On the laptop computer click on Start menu—> My Network Places and then click on the link
View Network Connections which is on the left side of My Network Places window.

"% Metwork Connections

Fle FEdit View Favorites Tools Advanced Help I3
1 ) @] = o
L€ P J L% >~ Search li' Folders
address | @) Network Connections v B
Dial-up
g ] @—'ﬂ 3G Connection
[l Create 2 new connection o] Disconnected, Firewalled
9 Setup a home or small \;L Conexant HDA D330 MDC V.9...

office netwark

@ Change Windows Firewall
settings

@5 1394 Connection @'ﬂ Wireless Network Connection
Connected, Firewalled | Connected, Frrewalled
See Also T oA, 1394 Net Adapter T G Dell Wireless 1395 WLAM Mini-...

i) Network Troubleshoote
N Tetwork Troublesnogter @Tﬁ Local Area Connection 2 @ﬁ'ﬂ Mebile Broadband Cannection

Connected, Firewalled Network cable unplugged, Fire...
T &, Sroadcom Nettreme 57xx Gig... & Del Wireless 5720 VZW Mobile...

LAN or High-Speed Internet

Other Places
2 Local Area Connection 4
G» Control Panel ] Disabled, Firewalled

&3 My Network Places T A, Cisco Systems VPN Adapter
[} My Documents

My Computer

Details

letwork Connections
System Folder

Figure 3.1: Network Connection Window

» Right click on the desired Local Area Connection (LAN) and select Properties (see Figure 3.1).
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>

>

>

-+ Local Area Connection 2 Properties |E|r5__(|

General | Advanced |

Connect using:
| B8 Broadcom Mettreme 57 Gigabit C ‘

Thig connection uges the following items:

B Deteministic Netwerk Erhancer ad
gFile and Printer Sharing for Microsoft Networks
QQUS Packet Scheduler -
¥~ Intemet Protocal (TCP/1P) ¥
< | &
[ Install... ] [ Uninstall ] [ Properties ]

Diescription

Allows your computer to access resources on a Microsoft
network.

[[] Show icon in notification area when connected
MNotify me when this connection has limited or no connectivity

[ 0K ][ Cancel ]

Figure 3.2: Local Area Connection Properties Window

Double Click on Internet Protocol (TCP/IP) (see Figure 3.2).

nternet Protocol (TCP/IP) Properties ?X

(General | Atemate Corfiguration |

If this computer is used on mare than one network, enter the atemate IP
settings below.

() Automatic private |P address
(® User corfigured

IP address:

Subnet mask:

Prefemed WINS server: I:l
Atemate WINS server: I:l

[ oK ][ Cancel ]

Figure 3.3: Internet Protocol Properties Window

If the Alternate Configuration (see Figure 3.3) tab is available, select User Configured, and fill
out the IP Address and the Subnet mask as shown. Click Ok.

This will enable you to connect up at any time without needing to reconfigure the IP port in the
future.

If the Alternate Configuration is not available, then you will need to change the IP address as
shown Figure 3.4. Note the original settings prior to making any changes.



f

General

You can get IP settings assigned automatically f your network supports
this capability. Otherwise, you need to ask your network administrator for
the appropriate IP settings.

(O Obtain an IP address automatically
(&) Use the following P address:

—
o
]
o
=]
%]
o
w0

IP address:

(]
£
n
]
£n
n
]
&

Subnet mask:

Default gateway:

(®) Use the following DNS server addresses:
Prefemed DNS server:

Altemate DNS server:

[ OK ][ Cancel ]

Figure 3.4: Internet Protocol Properties/General Window

You will need to perform this step (and reverse it back after completing use of TrafficDOT) every time

you use the laptop with the system.

3.2 Installation Procedure for TrafficDOT Application Software

» Put the TrafficDOT software media (CD) for windows version in the CD drive of the laptop.

Note: The Software can also be downloaded from the Dealer’s page on Sensys website.

&) TrafficDOT-1.8.4-7 : 06/30/09

License Agreement

Please review the license terms before installing
TrafficDOT-1.8.4-7,

Press Page Down ko see the rest of the agreement.,

COPYRIGHT (C) 2006, 2007, SENSYS NETWORKS, INC, ALL RIGHTS s
RESERMED

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE LISING

THE PROGRAMS, USE OF THE PROGRAMS INDICATES Y¥OUR

ACKMOWLEDGEMENT THAT ¥OU HAYE READ THIS LICEMSE, UNDERSTAMD IT,

ArD AGREE T BE BOURD BY  ITS TERMS AND CONDITIONS, IF ¥OU DO

MOT AGREE TO THESE TERMS AMD COMDITIONS, PROMPTLY RETURMN THE

PROGRAMS AND USER MANUALS TO THE PLACE OF PURCHASE AND Y OLUR

FPURCHASE PRICE WILL BE REFURDED, ¥OU AGREE THAT YOUR USE OF

THE PROGRAM ACKHMOWLEDGES THAT YOU HAVE READ THIS LICENSE, w

If wou accept the berms of the agreement, click I Agree to conkinue. You must accepk the
agreement ko install TrafficDoT-1.8.4-7,

[ I Agree ] [ Cancel

Figure 3.5: Installation License Agreement
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» Continue by clicking on the I Agree button (see Figure 3.5).

» Install all components of TrafficDOT by checking all the boxes in the Choose Components screen
(see Figure 3.6).

& TrafficDOT-1.8.4-7 : 06/30/09

Choose Components
Choose which features of TrafficDOT-1.5.4-7 vou want to install,

Check the components wou wank toinstall and uncheck the components vou don't wankt to
install, Click Mext ko continue.

Select components to install: TrafficDOT 1.6.4-7 Description
Start Menu Shorkcuts
Deskkop Menu Sharkcuks
Install Java Runtime 1.6
Space required: 22.3ME
< | s
[ < Back, ” Mext = l [ Cancel

Figure 3.6: Choose Installable Components Windows

> Click the Next button.

» If desired, change the Destination Folder for the software on the Choose Install Location window
(see Figure 3.7).
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B TrafficDOT-1.8.4-7 : 06/30/09

Chooze Install Location
Choose the Folder in which to install TrafficDOT-1.8.4-7.

Browse and select another Folder, Click Install bo start the installation,

Destination Folder

_:\Program FilesiSensys Metworks) TrafficDioT-1.8.4-7) | Erowse, ..

Sparce required: 22.3ME
Space available: 201.5G8

Setup will install TrafficDoT-1,8.4-7 in the Following Folder, To install in a different Folder, click

[ <= Back ” Install ] [ Cancel

Figure 3.7: Choose Install Location Window

» Click the Install button to begin the installation.

» The progress of the installation will be reported on the Installing window (see Figure 3.8).

® TrafficDOT-1.8.4-7 : 06/30/09 M=

Installing
Please wait while TrafficD0T-1.8.4-7 is being installed.

Execute: "Ci\Program Files!3ensys Metworks) TrafficDoT-1.8.4-Ajre-ous-windows-i556-p, exe

ARNAARNAARRR RN AR N RR N RN AR RN A RN AR RN AANNd |

Extract: mail. jar... 100%

Extract: spring.jar... 100%

Cutput Folder: Ci\Program Files!Sensys Mebworks! TrafficDOT-1.8.4-7\libexec

Cutput Folder: C:\Program Filest3ensys Metworks) TrafficDioT-1.5.4-7

Extract: ican.ica... 100%

Created uninstaller: C:\Program Files!Sensys Mebworks)\ TrafficDOT-1.8,4-7uninstall. . ..

Create shorkcut: CiDocuments and SettingstijlesikalDeskiop) TrafficDOT-1.8.4-7 .0k

Create Folder; Ci\Documents and SettingsijlesikalStart Menu\ProgramstSensys Mebw, ..
Create shorkcut: CiDocuments and SettingstjlesikalStart Menu\Programs|Sensys Ne. ..
Create shorkcub: CiDocuments and SettingstijlesikalSkark Menu)Programs|Sensys MNe. ..
Create shorkcut: CiDocuments and SettingstjlesikalStart MenulPrograms|Sensys Ne. ..

Execuke: "CiiProgram Files!Sensys Metworks TrafficDOT-1.8,4- 7\ jre-6ud-windows-is, ..

-

Figure 3.8: Installation Status Window
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Note: If the Java Runtime Environment is required, a separate installation process occurs.
Accept the Terms and Conditions to continue. Wait for the installation to complete. Click on
the Finish button.

» The results of the installation will appear on the installation window (see Figure 3.9).

® TrafficDOT-1.8.4-7 : 06/30/09 El=3

Installation Complete
Setup was completed successFully,

Completed

Extract: spring.jar... 100% A
Cutput Folder: :Program FilestSensys Metbworks! TrafficD0T-1,8,4-7ibexec

Cutput Folder: :Program FilestSensys Metworks! TrafficDQT-1,8,4-7

Extract: icon.ica, ., 100%

Created uninstaller: :iProgram FilesiSensys Networks) TrafficDOT-1.8.4-Fluninstall. ..
|Create folder: C:\Documents and Settingstjlesikalstart MenuiPrograms!Sensys Networks'l,TraFﬁcD
Create shorbeut: CDocuments and Settings|jlesikalatart MenulPrograms\Sensys he...
Create shorbeut: CiDocuments and Settingstjlesikalatart MenulProgramsiSensys he...
Create shorbeut: CiDocuments and Settingstjlesikalatart MenulProgramsiSensys he...
Create shorbeut: CiDocuments and SettingstjlesikalDeskiopt TrafficDoT-1.8.4-7.Ink
Execute: "C:\Program Files',Sensys Metworks) TrafficDoT-1,8,4-7jre-6us-windows-is. .
Completed

Close

Figure 3.9: Installation Completion Window

» Complete the TrafficDOT software setup wizard by clicking on the Close button.
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4. Configuring the Sensors Using the TrafficDOT Application Software

Sensors ship with a factory default configuration for count applications. In most cases, the configuration
is modified to fit the specific needs of an installation. However, once set, a sensor's configuration
typically requires no further changes.
Sensor configuration involves selecting values for the following parameters:

» Operating mode

» Radio Frequency Channel

From the main TrafficDOT window, select the Configure menu and click Sensors (see Figure 4.1).

Connect Cnnﬁgure| Control Tools

cansor Access Point .. F
011E Sensors.. 62 (

0Csg
0SDF Repeal ConfigLre SEFIS_UFS
01248 Controller Cards ... -81 {

Figure 4.1: Configure Sensors Window

The Sensor Configuration window appears (see Figure 4.2).

@ =55 Conhguration dda‘
r Configure Sensor

| Refresh Available List |

[ Jr

Available Selected
OB5SF
O0BDA
|Shcw all slats, including in used ones|
L] Time Siot: [§_[~| ]

0B13 03A3
0B7T9
0 o :
[] RF Chamnel: |Z|Z| \
[[] Recalibration:

| Apply all checkad parameters |

| BinkLED || Reset(keenRF) || HardReset |

| Download Firmware |

Figure 4.2: Sensor Configuration Window

Click Refresh Available List button and all the available sensors will be displayed.
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4.1 Selecting Sensors to Configure

Sensors are selected by moving their IDs from the Available list to the Selected list as follows:

From the Available list, click one or more sensor IDs. (Note: On Windows platforms hold down the
SHIFT key while clicking to select multiple entries in series.)

» Click the button labeled Add >>. The sensor ID(s) appear in the Selected list.
To remove IDs from the Selected list, do the following:
> From the Selected list, click one or more sensor IDs.

» Click << Remove. The sensor IDs are removed from the Selected list and appear in the Available
list.

4.2 Setting a Sensor's Operating Mode

The sensor's operating mode defines the type of detection data it transmits. To set the operating mode, do
the following after selecting the sensors to be configured:

» Fill the check box to the left of the label Mode by clicking it.
(The entries on the Mode drop-down list are the operating modes available for sensors.)

» Select an entry from the list by clicking it.
(Select Count (B), for the statistical count application).

4.3 Setting a Sensor's RF Channel

All sensors associated with an Access Point must use the same frequency as the Access Point. To set the
RF channel, do the following:

» Fill the check-box to the left of the label RF Channel by clicking it.

» The entries in the RF Channel drop-down list correspond to the 16 frequencies available for use.
Select an entry from the list by clicking it. Note: The factory default channel is zero.

» Click Apply all checked parameters.

4.4 Managing Sensor Tables and Lane Names

Access Points store information describing sensor locations and relative positions in two databases. The
databases are:

» Sensor Table — also referred to as the “dots” configuration table. This database stores an entry for
each sensor in the network including its lane position.

» Sensor-Pair Table — also referred to as the “dot pairs” configuration table. This database includes

one entry for each sensor-to-sensor relationship forming a speed pair (pair of sensors used to
measure vehicle speed).
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4.4.1 Adding a Dot (Sensor Table) Configuration Entry

To add a new entry, do the following:

From the Configure menu, navigate to Sensors and then click on the Dot Table in order to display the
table (see Figure 4.3).

>

Position the cursor in the Dotld16 column on a blank row. Type the 4-character HEX Id
(hexadecimal identification number) of the sensor.

If the sensor is used with a traffic controller, supply the card address in the column Address 170.
If the sensor is not used with a signal controller, type a zero into the field.

Type into the Lane field a short text description of the lane in which the sensor resides.

Type into the Position field an integer between 0 and 2 that indicates the sensor's relative position
in the lane.

Note: Positions are determined by counting up from zero in the direction of the traffic's travel.
That is, a vehicle will first drive over sensor zero, then sensor one and then sensor two. There is a
maximum of three sensors per lane. The sensor in position zero must be defined before the sensor
in position one, and position one must be defined before position two.

The check box at the left edge of the row designates the sensor as being included (or ignored) by
statistical or other applications. The check box is filled by default which indicates the sensor will
be included hence do not uncheck.)

Click Apply from the Operations menu to add the entry.
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-ulf'i‘gjh'r_e-z.s: Sensor Table (Dots Configuration table)

4.4.2 Adding a DotPairs (Sensor-Pair Table) Configuration Entry

The data contained in this table gives value added information from the detection events. For instance,

speed,

length gap and other values can be derived only by knowing the relative position and distance

between two sensors. To add a new entry, do the following:

>

>

From the Configure menu, navigate to Sensors and then Dot Pair Table (see Figure 4.4).
Fill the check-box to the left of the DotPairs Configuration table.

Position the cursor in the Leading Dot Id column on a blank row. Type the 4-character HEX Id of
a sensor.

Note: A leading sensor is the sensor that a vehicle first passes over when traveling in the direction
of normal traffic flow.

Type into the Trailing Dot Id field the 4-character HEX Id of a sensor.

Note: A trailing sensor is the sensor that a vehicle passes over second when traveling in the
direction of normal traffic flow.

Type into the Separation field a decimal value (in millimeters) specifying the physical distance
between the leading and trailing sensors.
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Operations

Figure 4.4 - DotPairs Configuration Window

» Click Apply from the Operations menu to add the entry.

Leading Dot Id Trailing Dot Id Separation
naGc2 naG3 GO96]| =~
L] 06C3 O6CH G056
0656 O67F G056
L] Q67F Qgc G026
D4A4 0437 6096| =
L] 0457 0653 6056
0494 04A0 6020
L] 0440 d4a1 G045
0452 0458 6045
L] D456 04354 6020
0401 0404 5954
L] 0404 0446 6020
QaD7 Qgcy G026
L] J6Ca a6ca G045
06E0 0650 6071
L] 0650 0643 6071
0671 0670 G056
L] 0670 OGEF 6056
JEBS OGBAC G056
L] O6AC 0672 G056
0756 0204 6071
| Successfully retrieved 23 rows from AP
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5. Initial Set up of the Access Point

The Access Point has to be correctly configured so as to be able to perform the statistics count
application.

5.1. Connecting the Laptop to the Access Box

Before you can set up/configure an Access Point, a connection between the laptop computer and the
access point (AP) must be established.

» Turn on the laptop.

» Plug one end of the Ethernet cable to the Ethernet -port of the laptop and the other end to the
Ethernet port of Access Box (See Figure 5.1).

Sensys Access Point

;

N

Laptop or PC

Sensys AccessBox

All connections are made with
CATS (or better) straight-through
Ethernet cables

Figure 5.1: Connecting an IP Device (Laptop) to a Sensys Access Box

5.2. Connecting to the Access Point via TrafficDOT Appricauur
» Double-click on the TrafficDOT icon on the desktop (shortcut).

» Type the access point’s IP Address and TCP Port (See Figure 5.2).
Default IP address: 192.168.2.100
Default TCP port: 20000

Note: It is recommended to use the default IP address and port number.
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IP Address [192.168.2.100 |
TCP Port [ 10000 |

| Connect || Discowver |

|
Figure 5.2: TrafficDOT Application Connection Window

> Click the Connect button.

Note: If the IP address of the access point is not known, click on Discover button. The Discover
button queries the local network and opens a window that lists All the Access points on the
network. Make a note of the IP address of the access point you wish to connect to. Click on
Dismiss button to close the window and return to connect window.

5.3 Configuring the Access Point

» To configure an Access Point, access the Configure menu and click Access Point (See Figure
5.3).

Connect Cunﬁgure| Conmtrol Tools

Sensor Access Point ... [ F
Se Configure Access Point|

Repeaters ...

Controller Cards ...

Figure 5.3: Configure Access Point Menu

The Access Point Configuration window appears with the current configuration data loaded into
its tabular display (See Figure 5.4).
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1 = = = = a
@ HCCESS FOInNt Saniguration dl ]Iﬂ

Operations

[[Radio | Event | Detection | Information

RF Channel 6 -

Radio Id

LNA Gain

PA Max. Power

PA Attenuation 0 dB -

| Successtully retrieved configurations from AP

Figure 5.4: Access Point Configuration Window

5.3.1 Setting the RF Channel
To set the RF channel, do the following:
» The entries in the RF Channel drop-down list correspond to the 16 frequencies available for use.
Select an entry from the list by clicking it. Note that the factory default channel is zero. The value
set on this section should correspond to the value set on the sensors’ configuration in Section 3.
» Click Apply from the Operations menu to apply the change or continue configuring the Access

Point.

5.3.2 Setting User ID and Password for FTP Services Hosted by the Access Point

Access points contain a local ftp server to provide a means of file transfer and disk access to authorized
users. The Access Point tab collects the user identifier and password string for the ftp user.

» From the Configure menu, click Preference (See Figure 5.5).
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Confgure | Comtrol 1)

Access Poink ...
Sensors ...
Repeaters ...

Conlroller Cands ...

Dot Tahle ...
Dot Fair 1able ..

Preference ...
— N

Figure 5.5: TrafficDOT Configure / Preference Menu

» Click on the Access Point tab (See Figure 5.6).

:@ Preference) d d E‘

Operations
Preference | Access Point |
Ftp User Id |r|:|0t |
Ftp User Password ocee |

Figure 5.6: User ID and Password
» Set the desired User ID and Password.
» Go to Operations then click Save.

5.3.3 Setting Up the Configuration for Bin Data Collection

After all the connections and set ups for the sensors have been completed, the configurations for bin data
collection can then be performed. From the main window of TrafficDOT go to the System ->
Configuration menu and perform the following:
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» Go to the Push tab (see Figure 5.7).
Push refers to movement of processed sensor statistical data from one host to another initiated by
an access point.

» Enter the 1st Destination IP. Enter the fixed IP address of the laptop as configured in Section 3
“Configuration of the Field Laptop Computer.” The IP address used was 192.168.2_99.

» Specify the Destination Port (required) (typically 10250 however any other port above 10000
can be used).

@) System Configuration

Operations

Caltrans D4 Poll | Marksman Poll | Advanced | Others |

Network VPN [ Push | Pon | Caltrans D3 Poll |
1st Destination Server (required) [192.168.2.99 [ =]
Destination Port (required) 10250 | ||
Buffer Reports
Stay Connected
Use Acknowledged Message Passing

1st Acknowledgement Timeout (s) | |

2nil Destination Server | |

Destination Port |

Buffer Reports
Stay Connected
Use Acknowledged Message Passing

2nd Acknowledgement Timeout (5) | |

Units |Imperi:al |v| L
Indmadual Car Reports |Disahle:l | - |
Report Interval |15 minutes | - |
Maximum File Size 100000 |
Average Speed L] -

Figure 5.7: System Configuration Window
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Verify that the following options are checked:
o Buffer Reports
e Stay Connected
e Use Acknowledged Message Passing

The following entries should be left blank:
e 1% Acknowledgement Timeout (s)
e 2" Destination Server
e Destination Port
e 2" Acknowledgement Timeout (s)

Uncheck Average Speed.

Set the Units to Imperial.

Verify that the Individual Car Reports entry is set to Disabled.
Set the Report Interval for bin collection to 15 minutes.

Set the Maximum file size to 300kB by entering 300000.
Note: Maximum file can be set up to 500kB. File size is determined by the number of lanes and
the length of time to be recorded.

While still on the System Configuration window, click on the Poll Tab (see Figure 5.8).

Set the TCP Port (required) to 1050.

Set the Operating Mode as Connection-based Polls using the dropdown menu.

Set the Units to Imperial

Set the Report Interval to 15 minutes.

Set the Individual Car Reports, the Speed Histogram, and the Length Histogram to Disable.
Set the Timestamp Option to End of Interval.

Set the Maximum file size to 300kB by entering 300000.
Note: Maximum file can be set up to 500kB. File size is determined by the number of lanes and
the length of time to be recorded.

Verify that the following are unchecked:
e Average Speed

e Use Diagnostic to correct Averages
o Display Diagnostics
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@ System Configuration

Operations
Caltrans D4 Poll Marksman Poll |/ Advanced |/ Others |
Network VPN | Push [ Pol | Caltrans D3 Poll
MNote: Valid AP-E License required
Sensys Poll Server:
TCP Port (required) 10250
Operating Mode Connection-based Polls -
Units Imperial -
Indmadual Car Reports Disabled -
Report Interval 15 minutes -
Maximum File Size |1 0o0on
Average Speed Ll
Speed Histogram Disahle -
Length Histogram Disahle -
Timestamp Option End of Interval -
Use Diagnostic to Correct Averages L
Display Diagnostics L]

Figure 5.8: System Configuration Window
5.3.4 Setting the Date via TrafficDOT
Click on the Others tab (see Figure 5.9) and do the following:
» Specify Free running in the Time Synchronization drop down menu.

> Set the correct time zone.
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» Set Serial Mode to RS485.
Note: RS485 sets the port for communications with traffic signal control equipment via a contact
closure card from Sensys Networks. This setting is mandatory for using the access point with
signal controllers.

@ System Configuration : E| [zl

Operations

Caltrans D4 Poll Marksman Poll rntwan{:ed |/ Others |

Network VPN | Push [ Poll | Caltrans D3 Poll
Master 170 Enable
Master 170 Logging Lewvel O -

Mote: Valid AP-E License required to run EventProxy

BEvent Port (required) |

Adaptive Holdowver O -
Time Synchronization Free Running -
Time Zone (recquired) ESTSEDT -
Serial Mode R5485 -

Figure 5.9: System Configuration Window->Others
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5.3.5 Saving the Configurations

» Click on Operations.

> Click on Save.

»  Click on Dismiss when finished saving (see Figure 5.10).

@

X

Updated Access Point Configuration;
Reboot to Activate New Configuration.

Dismiss

Figure 5.10: Successfully Saved Configuration Window

5.3.6 Rebooting the Access Point.

After all the configurations have been made to the access point, it has to be rebooted so as the changes to
take effect. This is very important and it is done via TrafficDOT’s Control menu (see Figure 5.11).

» Click on Control from main window and then select Reboot.

@ 192.168.2.100:10000 FEX

Connect Configure | Control | Tools System Log Help

Sensor D[ vers| Bun y ldle  |#Detections| RSS! Lal FER | Present Mode Slot Repeater | Channel Adv Settings
(9| BEDD 53: 7 3] 287| -B6 a5 -- B 18 Direct 10 ZEBX
9|  BABY 53. e 1 268 -82 94 - A B 42 Direct 10 78X
9| BE25 5333 3.63V 2 229 -76 95 - B g Direct 10 78X
~, SC4F 53.33 3.63V 7 311| -66 95 B 38 Direct 10 ZEBX

Figure 5.11: System Control Window
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5.3.7 Setting Date and Time via Telnet
» Reconnect the access point via TrafficDOT Application.
» Click on windows Start button and then click Run.

» Type telnet 192_.168.2.100 into the Open dialog box (see Figure 5.12) and then click
OK. This should open a new DOS window with prompt to log in (see Figure 5.13).

Run ?X
= Type the name of a program, folder, document, or

Cpen: elnet 192.168.2. 100 w

[ Ok H Cancel H Browse. ..

Figure 5.12: Performing a Telnet Connection in the Run Window

login

2% Telnet 192.168.2.100 _|o ﬂ
T =

Figure 5.13: Telnet Login Window 1
» Type the username (default login username is root) and then press ENTER on the keyboard.

» Type the correct password (see Figure 5.14).
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login: root
Pazsword:

& Telnet 192.168.2.100 = ﬂ
B

Figure 5.14: Telnet Login Window 2

» To set the date and time type “date-s YYYY.MM.DD-HH.MM” substituting YYYY, MM,
DD, HH and MM with the correct year, month, day, hour (24 hour clock) and minute,
respectively. The time entered should be in Greenwich Mean Time (GMT). For example, to
set the date and time to October 13, 2009 at 3:15PM EDT (Eastern Daylight Savings Time),
type date—s 2009.10.13-19:15 at the prompt (see Figure 5.15).

To adjust eastern time zone to GMT use the following:

1. For EST, add 5 hours (1 PM EST is 18:00)
2. For EDT, add 4 hours (1 PM EDT is 17:00)

2% Telnet 192.168.2.100 _|o ﬂ
B

login: root

Password:

it date —= 2087.18.13-18:15
Tue Oct 13 18:15:880 UTC 2889

Figure 5.15: Telnet Window for Date and Time Set Up
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6. Backing Up and Restoring the Access Point for Multiple Sites

This section is very important as it will enable the user to be able to store (back-up) a site configuration to
use the access point at another site. When returning to the original site, the user can restore the
configuration of the original site without having to repeat the lengthy setup. This can be extended to
storing the configurations for multiple temporary traffic count sites by using a haming convention that
allows the user to identify the back-up files from each traffic count site.

6.1 Backup of the Access Point Configuration

Backup activities are initiated from the System menu. Once the settings for a certain location have been
backed up, they can be retrieved next time when collecting data from that particular backed up site. Note:

Always perform back up for every first time site visit. To backup the current access point configuration,
do the following:

» Go to the TrafficDOT main window and select System -> Backup (see Figure 6.1).

© 192.168.2.100:10000

Connect Configure Control Tools gvslem| Log Help

Sensor D | Version | Battery | | Configuration ... PER | Present Mode Slo# | Repeater | Channel | Adv Settings
@| 8E2s | 5333 | 3eav Backup .. = B g Direct 10 Zex
9| SCAF | 5333 | asav = B EE Direct 10 78X
@9 SEDD | 5333 | 3.67V Restore ... B 18 Direct 10 78X
9| @ABO | 5333 | &7V Save Diag B 42 Direct 10 78X

Update Firmware ...

License ...

List processes running on AP
AP command line interface

| piscover:on | Channel: 10 Devices:4 01:57:35

Figure 6.1: TrafficDOT’s System Menu

The Backup VDS240 window will appear (see Figure 6.2).

» Name the file by typing the site name on the File Name text box. A good choice of file name
should identify the data collection site such as AP_site_3041. Optionally, store the file to
a different folder than the default.

» Click Save to backup the access point configuration to the file.
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X

@) Backup VDS240

Select a local tar file to save the current Access Point Configuration.
Save in: | =192.168.2.100.10000 =]
D appalachee_sitetar
[y test.tar
File Name: [site_3041 |
Files of Type: |tar files | - |
| Save | | Cancel |

Figure 6.2: Back-up VDS window

» Wait for back up to complete and click Dismiss (see Figure 6.3).

@

Backup Completed.

Dismiss

Figure 6.3: Back-up Completion Window

Note: The same procedure will be followed when backing up the configurations for all other temporary
traffic count sites. Using unique filenames including the site number will simplify identifying the correct
file to restore when the access point is again used at each site.
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6.2 Restoring the Configurations

The restore function in TrafficDOT can be used to quickly restore an access point to a site configuration
that has been saved using the backup function. To restore a previously saved site configuration, connect
to the access point using TrafficDOT and perform the following steps:

» Click Restore from the System menu. The Restore VDS240 window appears (see Figure 6.4).
(®) Restora VD540, X|

Select a tar file to restore the Access Point configuration. Reboot is required
after the Restore operation.

Look In: |7 192.168.2.92.10000 v

File Name: ||

Files of Type: [tar files -

Open Cancel

Figure 6.4: Restore VDS240 Window

» Select the file that contains the backup that will serve as the source for the restore. Optionally,
navigate to a different folder than the default.

» Click Open to restore the Access Point from the file.

» Reboot the access point by clicking on Control from main window and then selecting Reboot.
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7. Downloading Statistical Data and Exiting TrafficDOT

The Statistical data collected by the access point can be downloaded for the analysis via the web browser
using ftp connection between the laptop computer and the Access point.

7.1 Downloading Data

» Go to your Web browser (Recommended: Mozilla Firefox web browser).

Note: Microsoft Internet explorer could also be used. Prior to using the Microsoft Internet
Explorer for downloading the data, perform the following:

e Open Internet Explorer. Select Tools > Internet Options from the menu bar (see Figure
7.1).

; TACKtech Corp. - Microsoft Internet Explorer

| Fle Edt Wiew Favoites | Toos Help

" b ail and Mews L3 I .
Back - = X Ihtto: ~  Favorites
J O o \—LI "' Synchranize... ey

N | ddress [&] http:/ A tacktech  Windows Update -]

E Internet Options... \ - I
: W =l
ﬁ Enables pou to change settings. o

Figure 7.1: Internet Options

o Click on the Advanced tab. Uncheck the Enable folder view for FTP sites option. Click
the OK button (see Figure 7.2).

e Close Internet Explorer.

e Re-open Internet Explorer to apply the changes.

A-32



internetoptions g

Generall Securit_l..ll F'rivac_l..ll I:Dntentl Cnnnectinnal Progrars .ﬂ.dvanced[lk

Settings:

Browsing ;I
Always zend URLs az UTF-2 [requires restart]
Automatically check for Internet Explorer updates
Cloze unuzed folders in Higtory and Faworites [requires restart]
[ Dizable script debugging
[ Dizplaw a natification about ewvery script errar
Enakble folder wiewve for FTF sites
E&nable Inztall On Demand [Intermet Explorer]
F nable Inztall On Demand [Other]
Enable offline items to be sprchronized on a scheduls
Enable page transitions
[ Enable Personalized Favorites kenu
E nable third-party browser extenszions [requires restart)
[] Force offscreen compositing even under Terminal Server [requi
M atify when downloads complete

[0 Reuse windows far launching shortouts _|;|
4 | >

Bestore Defaults I

OF. ;l. Cancel | )] [ |

La
Figure 7.2: Enable folder view for FTP Sites option.

EOMETAMSTADS

On the web browser address bar, type “ftp://<username>@<ip address>" substituting
<username> with the username configured for the access point and <ip address> with the
configured IP address of the access point. For example, if the default IP address and username
were configured in the access point then type “ftp://root@192.168.2.100” into the address bar.

A pop up window asking for password should appear (see Figure 7.3).

Password Required g]

6 Enter password for root on ftp: /192, 163. 2, 100

[ 0K l [ Cancel

Figure 7.3: Password Request Pop up Window
Type the correct password and click OK. A list of folders will be displayed (see Figure 7.4).

Navigate to var/apstat_poll_tcp. A list of files will be available labeled using date format, double
click a file to open.

Select all the text in the file by pressing Ctrl+A on the keyboard, and then copy the text by
pressing Ctrl+C on the keyboard.
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3 Index of ftp://root@192.168.2.100/ - Mozilla Firefox
File Edit Wew History Bookmarks Tools Help

@ g C {a} ' B | fip:/f122.168.2. 100/ -] |G- P

&) Most Visited I Blackboard | ] Customize Links B ECE Overrides | ] F5UeSUSSAI ] FSU fyi ] FSUIEP Assessment [ | News I3 OMNI [ ) OurFAMU [ | Radio Links [ Weather

Index of ftp://root@192.168.2.100/

o Up to higher level directory

Name Size Last Modified
I bin 12/13/2008  12:00:00 AM
| boot 12/13/2008  12:00:00 AM
I dev 12/13/2008  12:00:00 AM
] etc 12/13/2008  12:00:00 AM
| home 12/13/2008  12:00:00 AM
1 lib 12/13/2008  12:00:00 AM
| mnt 12/13/2008  12:00:00 AM
| proc 11/30/198%  12:00:00 AM
shin 12/13/2008  12:00:00 AM
o 12/13/2008  12:00:00 AM
= usr 12/13/2008  12:00:00 AM
var 11301989 12:00:00 AM

Dane

Figure 7.4: Available Folders List Window
» Open a new file using notepad or Microsoft Word
» Paste the text into the file by pressing Ctrl+V on the keyboard.

> Save the file and close it.

Note: The files should be saved one after the other according to the dates they were created.
7.2 Exiting TraffficDOT

To end TrafficDOT session, do the following:

> From the Connect menu on the TrafficDOT main window, click Disconnect.
> Then click Exit.

Alternatively, you can close TrafficDOT by clicking the close window control in the upper right-hand
corner of the Access Point Control Center window.
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